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Preface

Conventions
This section describes some of the conven tions used in discussing the user interfaces.

User Actions

These are th e terms that will be u sed to describe u ser actions. 

Mouse

Point Move  cursor ov er a specific  object.

Click A standard single left click with the mouse or equivalent hardware.

Right Click A single click or the right mouse button.

Double Click Two rapid clicks with the left mouse button.

Drag Hold down the left mouse key, and move the mouse, thus moving some object on

the screen.

Keyboard

Press Press a key on the keyboard.

Enter Key in  some  inform ation a nd p ress the  Retu rn key.

Tab Press the Ta b key.

GUI Interaction

Enter Type text or numbers in a text box, text entry, or combo box.

Highlight Select text or other elements, usually by dragging with the mouse.

Activate Make a screen or dialog active and ready to receive input, usually by clicking on

its title bar.

Select Select a menu or sub-menu choice, or a listbox or combo box item.

Some selections require the user to navigate through several m enus, submen us,

or other GUI controls. These sequences will be shown with the name of each

control in bold, separated with “>” signs. For instance, to run SAS from the Start

button in MS Window s, you would need to click on the Start button, then the

Program menu item, then the SAS sub-menu, wh ere you would finally choose

the item labeled The SAS System for Windows V8. This would be represented

as follows:

Start > Programs > SAS > The SAS System for Windows V8
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GUI Elem ents

The name of visual GUI elements (except for screens and dialogs) will be placed in bold face

type. Typically the name is given by a label on the GUI element or widget. When this is not the

case additional explanation will be given.

GUI Element States

The widgets, whether screens, list boxes, or buttons, have several states. Not all widgets can take

all states. The states are described here along with their opposite states.

Activated The widget or screen is currently active and expecting input. Typically, the

widget or screen would also be highlighted at this time. Only one window can be

active at any given time. Its title bar is typically painted using a different color

than the non-activated window s.

Highlighted Either th e backg round  color is diffe rent than  norma l or a line or o ther grap hic

convention shows when a widget is highlighted.

Enabled This in dicates th at a widg et is usable  currently. It is n ot necess arily curren tly

active, bu t could b e made  active. O ften wid gets will get d isabled o r ‘greyed o ut’

when they are not appropriate to use under the current situation.

Other Typographical Conventions

File Names

File nam es and p ath nam es are set in b old font. F or exam ple wh en discu ssing a sp ecific file

extension (.msi), file name (setup.exe) or directory path (d:\program files) the text will be

formatted as shown.

Code and ASCII Output

Exam ples of program ming cod e, text for the user to en ter, and text outp ut from the p rograms are

set in   Courier New   typeface.
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Installation

Requirements
To install and use SHEDS, you will need a computer running SAS version 8.1 or higher. The

newer versions of the model have not been tested under SAS version 8.0, they may or may not

work on that version. On a computer running Windows 98, NT, or 2000 , it is necessary to have

a 300 M Hz proces sor,

64 MB of RAM, and

100 MB  of free disk space.

However, it is recommended that you have  

a 600 M Hz proces sor,

128 MB or more RAM, and 

more than 200 MB  of free disk space.

The software should run on other systems where SAS version 8.1 is implemented, but this has not

been tested.

If run un der W indow s 98 SE , SAS  8.1 or h igher is stron gly recomm ended  due to m emory leak s in

SAS version 8 .0 under these operating systems.

The model should run under other operating systems (non-Windows) as is or with minor

modifications. It has not, however, been tested und er other systems.

Installation Under MS Windows
The installation software used to build the install wizard for SHEDS is Wise for Windows. As the

name im plies this so ftware on ly works u nder M S Win dows in  its many va riations. T o install

under other operating systems one will need to request an alternate install package.

If you do not have Administrative privileges on your computer, you must either have the

administrator install the software or request a special distribution that can be installed without

administrative privileges.

Starting the Installation Process

The stand ard distribution  for SHE DS-W ood is by email or C D. 

Starting with a CD

If you received a CD, do the following.

1. Insert the CD  into your CD  reader. 
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Figure 1. The initial “Install” screen

if you have an old version of

SHEDS-Wood installed.

2. Use W indows E xplorer to nav igate to the top level files on th e CD. 

3. Double click on the setup.exe file to initiate the installation.

Starting with an Email Distribution

You m ay receive th e installation  file via an em ail attachm ent. If so, follo w these in struction s to

start the install process.

1. Save th e attachm ent to a loca l or netwo rk hard d rive. Th e metho d you us e to do this  will

vary depending on the email program used. Make sure the saved file has an extension of

“.msi”. A typical name might be ShedsW oodv4 01.msi .

2. Use the Windows explorer to navigate to the saved file.

3. Double click on the saved file to start the installation.

The Standard Installation Process

Once the installation wizard is initiated, simply follow the

instructions. This will install the necessary program and

data files, define an environmental variable called

WOO D_MO DEL_RO OT, and place a desktop icon used

to execu te SAS  and start th e mode l.

If the user has an earlier version of SHEDS-Wood

installed, the user will initially see the screen in Figure 1.

Select Remove, follow the instructions, and start the

installation process again to install the new version.

The typical screens and an exp lanation of each are shown in the following figures.
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Figure 2. The initial welcome screen displayed

while the installer prepares its files and searches

for the installed SAS software.

The first installation scree n appears fo r a

short time while the installer searches the

user’s co mpu ter for SA S. If SA S version  8 is

found the installation will continue with the

next screen.

This screen simply specifies which version

will be installed. E xit any unne cessary

programs before the install. Click the Next

button to continue.

Figure 3. The welcome screen for the SHEDS-

Wood installation.
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Figure 4. Installation location window.

Figure 5. File navigation window.

Figure 6. Confirmation window.

This scr een give s the user  a chanc e to install

the files som ewhere  besides  the defau lt

location, 

     C:\Program Fi les\sheds_wood\.

If the user desires, the Brow se button can be

clicked and a dialog allowing him to choo se

an alternate location will come up. See the

next screen.

If the Browse button is clicked on the

previous dialog, this dialog appears. It is used

to naviga te the disk  drives an d directo ries to

specify the location for the top level

installa tion d irectory.

This is the final window before install begins.

It allows the user to go back and change any

values entered.
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Figure 7. Installation progress dialog.

Figure 8. The final installation screen.

While the installer is copying files to the

installation  directory, a b lue prog ress bar w ill

be displayed. This step should take less than

one minute.

After the files have been extracted and placed

in the sheds directory, and the desktop icon

has been placed, this dialog will indicate that

the installation is complete.

Be sure to w ait at least 20 second s before

attempting to start the SHEDS-W ood

interface.

On some Windows systems (95, 98SE) the

user may need  to reboot the com puter before

SHE DS will lau nch witho ut error.

Installation  Details

The installation basically carries out three operations.

1. Uncompress and copy files to desired location.

2. Create a desktop icon to start SAS and the model interface.

3. Define a User Environmental Variable, WOOD_ MOD EL_ROO T, that points to the top

level of  the ins tallation  directo ry.
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Figure 9. Desktop icon.

Figure 1 0. The  control p anel.

Starting the Model Interface

The installation w ill place an icon on  the user’s desk top (Figure 9 ).

Double click on the icon to start SAS and the main screen of the

SHEDS  Interface. See the section on “Navigating in SAS” for

additional information on opening Log or Output windows and

viewing results.

Removing SHEDS-Wood
If SHE DS w as installed  using th e installation  wizard, th en the u ser can u ninstall it as o ne wou ld

most any windows program. This process will not remove the user’s simulation output files. They

will need to be removed by hand.

To start the removal process, click the Window s Start button. Go to Settings, then Control

Panel (Start> Setting s>Co ntrol P anel) . The following figures and text describe the remainder of

the process.

Typical ap pearan ce of the C ontrol Pa nel.
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Figure 11. The Add/Rem ove Programs icon

in the C ontrol Pa nel.

Figure 12. List of programs that can be

uninstalled using Add /Remove Program s.

Figure 13. Expanded description of the

SHEDS Program.

Double click on the Add/Remove Programs

icon

In the Add/Remove Programs dialog, find the

entry for SH EDS -Wood  and click  on it.

The entry will expand. Click on the Remove

button and follow the instructions.
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Figure 14. The SAS screen showing the narrow

tabbed windows to the left and a blank work area.

Figure 15 The main SAS  screen showing the layout of the user interface

and several model outpu ts.

The SAS User Interface

The SAS Screen
The SAS screen is split into a number of

distinct areas (Figures 14 and 15). At the top

are the title bar, menu bar, and tool bar. SAS

puts m ost dialog s and ou tput in th e main

work area (empty in Figure 14, and

containing many windows in Figure 15). At

the bottom of the work area are a series of

buttons each representing one window in the

work area. Windows can be selected by

clicking on these buttons.

To the left of the main work area there can

be a narrow  set of tabbed w indows (F igure

14). The tabbed

window s are

typically the SAS

Explorer and the

Results Ex plorer,

although other

windows can be

displayed there.

When displayed, the

user can switch

between these

windows using the

tabs at the bottom.

Standard SAS output

goes to one of three

window types in the

main S AS sc reen. A ll

system messages,

errors, and

occasional program
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NOTE: The SHEDS Interface does not use the standard Graph Window as described here. The

interface w ill display gra phs in in dividu al wind ows. A ddition ally, most tab ular outp ut is access ible

through the interface.

Figure 16. Main dialog of SHEDS-W ood at

startup.

Figure 1 7. Icons u sed to

minimize, maximize and

close SAS wind ows.

Figure 18. The SAS

View menu.

comments are put in the Log screen.  There is one Log screen shared by all SAS prog rams.

Charts and plots are output to the Graph windo w. Gra phic ou tput from  all program s are put in

the sam e wind ow. Th is wind ow often  does no t automa tically scroll do wn so you  must scro ll it to

the bottom to see your new chart. Tabular information goes to the Output window.

Setting Up the Work Area
SHE DS typ ically starts with  only the m ain

work area active. The main SHEDS dialog

may be max imized, taking u p the entire

working area  (Figure 16 ). 

How To

Expose the work area

If the SHEDS main menu

is occupying the  entire

work area then click on

the small middle icon at

the upper left on the gray

bar (Figure 17). The

upper set applies to the entire SAS application window. The lower set applies

to the current window in the work area.

Display the Log Window

SAS  sends m essages an d notes to  its Log W indow . If this wind ow is no t open in

the main work area, select the View  menu  (Figure  18) an d select Log

(View>Log). If the Log Window is open, but not visible, click on the button for

the log beneath the main work area.
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NOT E: SHED S’ results are typically viewed using the output menus in the m odel interface. These

will be discussed shortly. The discussion here addresses use of SAS independent of SHEDS.

Figure 19 The Explorer

window in SAS.

Display the Output Window

The Output W indow is where SAS sends tabular output from

statistical procedures. After each simulation SHEDS puts some

basic statistics about the calculated exposures in the Output

Window. Like the Log Window  it can be opened with SAS’s

View menu (View>Output).

Display the SAS Explorer

The SAS exp lorer is used to navigate SAS libraries and catalogs

(Figure 19). The libraries contain the data and code used by or

produced by SHED S. Selecting Con tents O nly  from the SAS

View  menu will display the explorer window (View> Conte nts

Only ).

Display the SAS Results Explorer

This window is used to navigate results in the Output Window

(Figure  20). It use s an exp andab le node  format allo wing on e to

progressively delve into the output for each run. It can be

displayed by selecting Results  from the SAS View  menu

(View> Results ).

Navigate Procedure Output in Results

Each time new tabular output is created from a SAS procedure, another entry is added to the SAS

Results  window (Figure 20). Clicking on one of the plus signs opens up one output set. Clicking

on a particular entry in the output set opens the corresponding window and brings it in front of

the other windows for viewing. You can scroll through that window using the sliders to the right

of the window.

Navigate Data Sets in SAS Explorer

The SHED S model uses and creates many data sets; in SAS, a data set is essentially a table of

data. Th e Exp lorer win dow is u sed to na vigate the  data sets. In itially, the Ex plorer w indow  will

have two icons. Double click on the filing cabinet to get a list of the directories (folders) that

contain  data sets, sh own w ith file draw er icons.  D ouble c licking on  these will sh ow the d ata sets
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Figure 2 0 The  Results w indow  in

SAS.

or additional folders. Double clicking on one of the data set

icons, a square table with a red dot, will bring the data set

into a visible table showing column names at the top and

values below.

To move up the directories (i.e., into the parent directory or

folder)  make the Explorer Window active (clicking on the

title bar or tab  will activate it).  Then  click on th e Mov e to

Parent to ol ( ) just above and to the right on the SAS

tool bar.  
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Figure 21. The main dialog for the SHEDS user

interface.

SHEDS-Wood Graphical User Interface

Main Window
SHE DS’ m ain dialog  (Figure  21) inc ludes se ven bu ttons:  

1. Select E xposu re Scen ario , 

2. Specif y Mo del Sce nario ,

3. Edit Inp uts,

4. Run Simulation,

5. View R esults,

6. Manag e Output Files, and 

7. Exit .

Initially, the only enabled b uttons are

Select E xposu re Scen ario , View

Results , Manag e Output Files, and

Exit .  These  button s allow the  user to

view results and manage files from

previou s SHE DS sim ulations,  or to

move throu gh the prop er sequenc e of steps to cond uct a new m odel run.  A fter the exposu re

scenario is specified with the Select E xposu re Scen ario  button, the Specif y Mo del Sce nario

button becomes enabled.  After the user specifies the model scenario, the Edit Inp uts and Run

Simulation buttons are enabled.  Both of these buttons are enabled since the user is not required

to edit inputs prior to running a simulation.

Indicated on the bottom of the M ain screen are the SHED S model version num ber and date of last

changes.

The following sections detail the results of selecting each of the main window  buttons.

Select Exposure Scenario
This dialog (Figure 22) allows the user to select which SHEDS exposure scenario(s) will be

includ ed with  a new S HED S simu lation.  Fo r the pu rposes of  peer revie w, the on ly available

option in  this version  of SHE DS is  Wood P reservatives.  Other exposure scenarios that have

currently been im plemented  in SHE DS (lawn , garden, ind oor crack and  crevice treatment) or are

plann ed for inc lusion in  the near f uture (e.g ., pets, bro adcast, fo gger) are liste d with a n “N A” to

indicate “Not Activated” in this version.
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Figure 22. Scenario exposure selection dialog.

Figure 23. The scenario specification dialog.

NOTE: Depending on the size of your screen, it may be necessary to scroll down on this and

other dialogs to see th e bottom po rtion of a list box or of the  dialog itself.

If the user clicks on the Select Exposure

Scena rio button, and does not select “Wood

Preservatives,” an error message appears:

“On ly the Wo od Pres ervatives sc enario is

supported  by the interface at this time.”

Specify Model Scenario
Clicking on this button pops up a dialog

(Figure 23) that allows the user to set

various options for a new simulation. The

dialog is separated into three sections using

container boxes: SPECIFY

SIMULATION, SPECIFY

POPULATION,  AND SPECIFY INPUT AND OUTPUT DATASETS.
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Specify Simulation

The Input Dataset  box in the upper left corner of the screen allows the user to select whether

SHE DS sh ould u se a pred efined d efault da taset or a cu stom da taset. If the “P redefine d” optio n is

selected, then the input dataset is determined by the choice of the chemical name, climate, and

simulation time-period. The user cannot select an input dataset in the SPECIFY INPUT AND

OUTPUT DATASETS box (i.e., the Select In put F ile button is not av ailable).  

If the “Custom” option is selected, the user must select an input dataset by clicking on the Select

Inpu t File  button. In this case the chemical name and climate entered serve only as labels in the

output; they do not affect the simulation.

The Clima te allows the  user to sp ecify whe ther a wa rm or cold  climate is b eing sim ulated to

assess children’s exposure to a wood preservative from playsets and home decks.  The predefined

files contain parameters specific to warm or cold seasons.

The Simulation Time-Period allows the user to specify the simulation length and averaging

time.  

1. Short-term (1-30 days) The mo del uses a 15 -day averaging time . 

2. Intermediate-term (1-6 months) The model uses a 90-day averaging time.

3. Lifetime (75 years) The m odel sim ulates ind ividuals o ver their

lifetimes.

The Short-term and Interm ediate-term simulations use 15-day, and 90-day time periods,

respectively. Each simulation for an individual is started at a randomly selected day and runs for

the time p eriod ind icated. In th ese cases th e average  daily abso rbed d ose that S HED S com putes is

calculated based on these time periods.

For the lifetime simulations, an individual is simulated for six full years. The method for

calculating the lifetime average absorbed dose is described in the SHEDS-Wood P reservatives

Technica l Manu al.  

The SAMPLING METHOD box allows the user to specify “Variability” or “Uncertainty”,

which will determine whether a 1-stage or 2-stage Monte-Carlo analysis will be used. This choice

will affect th e form of th e param eter inpu ts required  by SH EDS , as well as th e types of av ailable

outputs. For additional discussion of M onte-Carlo simulation see the “Backgrou nd Topics”

chapter.
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NOTE : All simulation output is placed in predetermined libraries. These libraries are:

as_outv: Variab ility outputs

as_outu: Unce rtainty outp uts

Metadata are stored in as_idv and as_idu, but the user will probably not have much need for

these outputs.

NO TE: T he inp ut data sets are  initially re ad from  the as_ dtain  library.

Specify Population

In the SPECIFY POPULATION box the user selects Ages(s) and Gender of interest in the

simulation. All ages from 1-6 years, or any subset of those ages are available for selection. The

Size of Population combobox allows the user to specify the sample size for the 1-stage

simulation.  If “Uncertainty” has been selected as the sampling method, then an additional

combobox (Number of Populations) appears for the user to specify the number of populations of

input distribu tions to be simu lated in the 2-stage M onte Carlo sim ulation. 

The time taken to carry out the simulation increases linearly with the size of population and

numb er of population s selected. The re is a lesser increase in run  time if longer time-pe riods are

chosen. Examples of simulation times are given in Table 2 on page 19.

Specify In put and O utput Datas ets

The SPECIFY INPUT AND OUTPUT DATASETS box allows the user specify the input

dataset and name the output file containing simulation results. The button to change the input

dataset will only be enabled if a custom file was specified in the Input D ataset box. To change

the input file click the Select In put F ile button. To name the output dataset, simply edit the text

in the text box. The name entered will be prefixed to all output dataset names. The suffixes on the

names  indicate th e type of da taset.
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Figure 24. The main editing dialog.

Figure 25. An example variability distribution

editing dialog.

Edit Inputs

The Main Editing Dialog

Selecting the Edit Inp uts button  allows the  user to

edit the parameters in the user-specified input file.

Initially, a screen appears (Figure 24) displaying the

categories  of inpu t parame ters in the file .  The d efault

file contains the following categories:

• Activity factors

• Dose Fac tors

• Exposu re Factors

• Soil con centration s and res idue lev els

around/on decks, and 

• Soil con centration s and res idue lev els

around/on playsets.

Doub le clicking  on a categ ory in the list b ox cho oses that ca tegory, disp laying a dia log used  to

edit the variability or uncertainty distributions of its input parameters. The dialogs for each

category are nearly identica l in most respects. H owever, those  used to edit variab ility parameters

are different from those used to edit uncertainty parameters. The type of run specified in the

Sampling Method box of the Scenario Specification dialog determines whether variability or

uncerta inty param eters are sh own h ere. Th e details of a ctually editin g individ ual para meters w ill

be cov ered sh ortly.

The other box that app ears in the Edit Inputs dialog is  NAME INPUT DATA.  As indicated on

the screen, the user can discard changes made to the input file after the simulation by hitting the

Exit  button  after mak ing cha nges.  A lternatively, th e user can  save the c hange s made  to the inp uts

with either the same name or a different one

typed in this box, by clicking the Save button.

Editing Variability Parameters

An exa mple dialog fo r variability parameters

is shown in Figure 25. A title at the top

indicates the category being edited. The

length of the dialogs vary depending on the

number of parameters in the category. For
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Distribution

Number of

Param eters Parameter Names

Point 1 Value

Uniform 2 Minimum, Maximum

Normal 2 Mean, Standard Deviation

Log Normal 2 Geo Mean, G eo Standard

Deviation

Triangle 3 Minimum, Mode, M aximum

Table 1. Distributions supported in SHEDS.

Figure 26. Examples of all supported distributions in the

variability distribution editing dialog.

some categories it is necessary to scroll down the dialog to see the bottom where the Save and

Cancel buttons are. 

There is one container box for each parameter. A description of the parameter is given across top

of the bo x. With in the bo x, in the f irst colum n, the type  of variability d istribution  is specified  with

a pull do wn list. (S ee the “B ackgrou nd To pics” ch apter for in formation  on distrib utions.) O ne to

three tex t entry box es appe ar below  labels in th e second  through  fourth co lumns. An ap propriate

num ber app ear to spec ify values for  the chos en distrib ution. T he labels  above th e boxe s indicate

the distrib ution p arameter  to be edite d. See T able 1 fo r distribu tions sup ported a nd their

parameters.

The n umb er of text b oxes w ill

change as the distribution is changed

(Figure 26 ). Invalid num bers are

highlighted  in yellow (Figure 2 7).

These will typically occur when the

user changes the distribution to one

with a greater number of param eters.

Boxes which contain invalid values

will be colored in  red (Figure 2 8).

An invalid value might be one that

contains a neg ative standard

deviation  or a minim um tha t is

greater than the maximum.

The Save button  saves the c urrently

displayed  parame ter values b ack to

the parameter dataset. The Save

button  is disabled  while an y invalid

values are on the form. The Cancel

button exits this screen without

saving any values.
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NOTE: In this version of the model the minimum or maximum of a triangle distribution cannot be

the same as the mode.

Figure 27. Non-numbers highlighted in yellow.

Figure 28. Invalid values highlighted in red.

Figure 29. Uncertainty parameter editing dialog.

Editing Uncertainty Parameters

Editing uncertainty parameters works in essentially the same mann er as variability parameters.

The big d ifference is that there is on e uncertainty distribu tion for each variab ility parameter.

Figure 2 9 show s an exa mple u ncertain ty

editing screen for two parameters. The top

row contains the variability distribution.

There will be from one to three

distributions below that, one for each

param eter. Each  individ ual unc ertainty

distribution works essentially like the

variability parameters. The number of text

boxes to enter values will change based on

the distribution.
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NOT E: If you are definin g an unce rtainty run and d o not want to in clude un certainty in one or m ore

parameters, then define each distribution for the variability parameters as a point distribution. For

example if you wanted define the parameter value as a point in all uncertainty runs, change the

variability dis tribution  to ‘Poin t’. One  uncerta inty distribu tion will b e displayed . Chan ge this

distribution to ‘Point’ and define the value desired.

NOTE: Although values are checked within each uncertainty distribution, there is no check on the

validity of the relationships among the uncertainty distributions

Simulation

Time Period Variab ility Uncertainty For uncertainty runs, the number of

individual iterations is equal to the size of

the population multiplied by the number

of samples. A user running 100

individuals and 10 u ncertainty samples,

results in 1000 individual iterations.

Short 7.6 11.7

Intermed iate 8.8 12.6

Lifetime 93 108

Table 2. Minutes to execute 1000 individuals (iterations) for short, intermediate, and lifetime

simulations using either variability or uncertainty sampling.

Run Simulation
After specifying the scenario and model inputs, the user can press the Run Simulation button  to

start the model run.  When the simulation is completed, a pop-up message appears.  To track the

iteration while the model is running, the user can click on the Log menu bar at the bottom of the

interface.  After viewing the Log, the user should click back on the menu bar with “SHED S” at

the bottom of the interface screen.

Duration of Simulations

The time it takes to run a simulation depends on: the speed of your computer, the size of

popu lation, the  numb er of unc ertainty pop ulations (if  any), and  wheth er the sim ulation is sh ort-

term, me dium-term, or lifetim e. It is difficult to s ay how lo ng a sim ulation w ill take on a specific

machine. Table 2  indicates some typical simulation times on a 900 MHz PC.
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Time = 11:23:36

 Person=1    gender=M  age=5   start day=149  Percent Done=33.33

 Person=2    gender=M  age=2   start day=59   Percent Done=66.67

 Person=3    gender=F  age=3   start day=330  Percent Done=100.00

Stop Time = 11:23:38

Table 3. Logging du ring variability simulations.

Time = 11:22:58

Uncert Iter=1    Person=1    gender=F  age=2   start day=203  Percent Done=16.67

Uncert Iter=1    Person=2    gender=F  age=5   start day=212  Percent Done=33.33

Uncert Iter=1    Person=3    gender=M  age=6   start day=200  Percent Done=50.00

Time = 11:23:01

Uncert Iter=2    Person=1    gender=F  age=3   start day=94   Percent Done=66.67

Uncert Iter=2    Person=2    gender=F  age=5   start day=103  Percent Done=83.33

Uncert Iter=2    Person=3    gender=M  age=1   start day=59   Percent Done=100.00

Stop Time = 11:23:03

Table 4. Logging du ring uncertainty runs.

Logging of Simulation Progress

During the simulation, the individuals being simulated and progress on the entire run will be

printed to the L og Wind ow. Du ring variability runs, the p erson ID, gen der, age, simu lation start

day (i.e., be tween 1  and 35 1), and  percen t comple tion are p rinted to th e log (Table 3). O ne line is

printed for each  individual. T he time is printed  at the beginn ing and en d of the simu lation. 

Durin g unce rtainty simu lations this  same in formation  is logged.  Add itionally, the u ncertain ty

iteration is printed with the output for each individual and the time is printed at the beginning of

each unc ertainty iteration (Table 4 ). 
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Figure 30. Dialog to specify analysis of simulation results.

View Results
Model results from current or previous SHEDS  simulations can be viewed by pressing the View

Results  button. This opens a dialog (Figure 30)  to specify desired  outputs. There are a variety of

graphical and tabular outputs available. The specifications and output options change based on

the sam pling m ethod u sed and  result type o f interest.

Select the Wood

Preserva tive scena rio

in the top left combo

box; th is is the only

scenario  available in

this version of SHEDS.

Then select the

sampling method

(uncertainty or

variability) and the

population type

(population or

individual) currently of

interest in the two

radio boxes  below. A

list of the available output datasets will be put in the Select Output File To Analyze  combobox.

Select the file to analyze and continue.

Manua l Sensitivity A nalysis

Automated procedures for conducting sensitivity analyses are not implemented in this version of

SHED S.  To determine wh ich input variables contribute the most to variability in model outputs,

the user can fix each input value as a point estimate, then vary one at a time (e.g., increase then

decrease  by a factor of  2) keep ing the re st fixed, an d comp aring ou tput resu lts for variab ility

simulations.

Variability Results for a Population

If the user selects “V ariability” as the sample m ethod and  “Popu lation” as the “R esult Type,”

options will app ear for the user to spe cify the Gend er(s) (Male, Fem ale, or Both), Start A ge (yrs),

and Stop Age (yrs) corresponding to the model simulation results/output file selected.  The

“Gender” and “Age” selected on this screen will appear on the output tables and graphics selected

by the user.  
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NOTE: IT IS THE USER’S RESPONSIBILITY TO SELECT THE CORRECT GENDER

AND AGE CORRESPONDING TO THE SELECTED OUTPUT FILE TO ANALYZE.

Figure 31. Example summary table for a population.

The output options for viewing variability results for a population are listed in the SELECT

OUTPUT TYPE FOR POPULATION box: 

• Summary Table,

• CDF,

• Box and Whiskers, and 

• Contribu tion by Pathw ay.  

For each of these output types, the user must select (by clicking) variable(s) of interest from the

Select Variable(s)  listbox.  The selected variables will appear in the Selected Variables listbox. 

The av ailable ou tput varia bles are d escribed  in Tab le 5. To u nselect a v ariable, click  on it again  in

the Select Variable(s)  listbox.

Summary Table

This yield s a summ ary statistics table

(Figure 31) for the selected dose

variable(s) and specified model

simulatio n, descr ibing th e basic

distribu tion of the  variable: sa mple

size, mean, standard deviation, median

(p50), 5 th percentile (p05), 25th

percentile (p25), 75th percentile (p75 ),

95 th percentile (p95), and maximum.

Cumulative Density Function

This yields a cumulative density function (CD F) plot (Figure 32) for the selected dose variable(s)

and specified model simulation. The CDF shows the percent of the population that had less than a

specific value for a sim ulation run. T he whole p opulation is rep resented in on e curve. Th e entire

population has values of less than or equal to the maximum which occurs at the 100th percentile. 

The percentile is given on the X-A xis. The value for the output variable is given on the Y -Axis.

The median value for a variable will occur at the 50 th percentile.
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Figure 32. Example CDF for a population.

Figure 33. Example of Box and Whiskers plot for a population.

 Box and Whiskers

This yields a box and whiskers plot (Figure 33) for the selected dose variable(s) and specified

model simulation.  The box and

whiskers plot shows the

distribution of a variable for the

entire p opulation g raph ically.

Each column, three in the

example, represents one

variable described in the legend.

The abso lute variable value s are

given on the Y-Axis. The

rectangle represents the median

and one quartile above and

below th e media n. The  tails

extend to the 5th and 95th

percentiles.
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Figure 34. Example of the contribution by pathway

chart.

Contribution by Pathway

This yields a pie chart (Figure 34) showing p ercent contribution of each pathway to the total dose

(based on population means) for the

following path ways (See Ta ble 5):

• Comb ined Surf D erm Dose , 

• Comb ined Soil D erm Dose , 

• Combined  Surf Inges-

HandToMouth Dose, and 

• Combined Soil Inges – Direct

Dose.  

The u ser does n ot have th e option  to

select variab les for this ou tput ( i.e., the

Select Variable(s)  and Selected

Variables listboxes do n ot appear).

Variability Results for an Individual

If the user selects “V ariability” as the sample m ethod and  “Individua l” as the “Resu lt Type,”

options will appear for the user to “Select Individual”, “Start Date” and “Stop Date” of the

calendar year for that individual in the model simulation results/output file selected.  The output

options for viewing variability results for an individual are listed in the “SELECT OUTPUT

TYP E FO R IND IVIDU AL” b ox: 

• Detailed D ata, 

• Absorbed Dose Time Profile, and 

• Contribu tion by Pathw ay.  

For each of these output types, the user must select (by clicking) variable(s) of interest from the

“Select Va riable(s)” box.  T he selected variab les will appear in th e “Selected V ariables” box. 

Options for o utput variables  are the same as th e previous section  (Table  5).
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Playset Surf Derm-H ands Dose (ab sorbed dose fro m dermal hand c ontact with playset surfaces)

Playset Surf Derm-B ody Dose (ab sorbed dose fro m dermal bod y contact with playset surfaces)

Playset Soil Derm –  Hands Do se (absorbed d ose from dermal ha nd contact with soil around p laysets)

Playset Soil Derm-B ody Dose (ab sorbed dose fro m dermal bod y contact with soil around playsets)

Playset Surf Inges-HandToMouth Dose (absorb ed dose from ingested playset surface residues from hand-in-

mouth events)

Playset Soil Inges – Direct D ose (absorbed  dose from ingested soil aro und playsets)

Playset Surf Derm D ose (absorbed  dose from hand a nd body derm al contact with playset surfaces)

Playset Soil Derm D ose (absorbed  dose from hand a nd body derm al contact with soil around playsets)

Playset Total Dose (total absorbed dose from playsets) 

Deck Surf De rm-Hands D ose (absorbed  dose from derm al hand contact with deck surface s)

Deck Surf De rm-Body D ose (absorbed  dose from derm al body contact with deck su rfaces)

Deck Soil De rm – Hands D ose (absorbed  dose from derm al hand contact with soil around d ecks)

Deck Soil De rm-Body D ose (absorbed  dose from derm al body contact with soil around  decks)

Deck Su rf Inges-Han dToM outh Do se (absorb ed dose  from ingested  deck surfac e residues fro m hand-in-m outh

events)

Deck Soil Inges – D irect Dose (absorb ed dose from ingested  soil around decks)

Deck Surf De rm Dose (abso rbed dose from  hand and bod y dermal contact with deck surface s)

Deck Soil De rm Dose (abso rbed dose from  hand and bod y dermal contact with soil around  decks)

Deck To tal Dose (total absorbe d dose from de cks)

Combined  Surf Derm-Han ds Dose (abso rbed dose from  dermal hand co ntact with playset and deck surfaces)

Combined  Surf Derm-Bo dy Dose (abso rbed dose from  dermal body co ntact with playset and deck surfaces)

Combined Soil Derm – H ands Dose (absorbed dose from derm al hand contact with soil around playsets and

decks)

Combined  Soil Derm-Bo dy Dose (abso rbed dose from  dermal body co ntact with soil around playsets and dec ks)

Combined Surf Inges-HandToMouth Dose (absorbed dose from ingested playset and deck surface residues from

hand-in-mouth events)

Combined  Soil Inges – Direct Do se (absorbed d ose from ingested soil around  playsets and decks)

Combined  Surf Derm Do se (absorbed d ose from hand and  body dermal co ntact with playset and deck surfaces)

Combined Soil Derm D ose (absorbed dose from hand and bod y dermal contact with soil around playsets and

decks)

Total Dose (to tal absorbed do se from playsets and decks)

Table 5. Outpu t variable descriptions.
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Figure 3 5. Exa mple d etailed da ta table for an indiv idual.

Figure 3 6. Exa mple ab sorbed  dose tim e profile for  an indiv idual.

Detailed Data

This  displa ys

information for

the selected

individual and

simulated d ays

(Figure 35 ).

Variables shown

include date, day

num ber (1 to

366), gen der,

age, body weight

(kg), child ID,

and the  daily

dose averages

for the selected

variables.  

Absorbed Dose Time Profile

A dos e profile

(Figure  36) is

plotted w ith

absorbed dose on

the y-axis and day

on the x-axis, for

the selected

variables. The x-

axis defa ults to

the days an

individual was

simulated, but can

be changed in the

output

specification

dialog.
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Figure 3 7. Exa mple “ Contrib ution b y Pathw ay” pie ch art for an in dividu al.

Contribution by Pathway

A pie  chart sh owin g each  pathw ay’s pe rcent c ontrib ution  to total d ose is d isplayed. Th e path ways

represen ted are fix ed: 

1. Combined Surf Derm D ose,

2. Comb ined Soil D erm Dose , 

3. Combined Surf Inges-HandToMouth Dose, and 

4. Comb ined Soil Inges  – Direct D ose.  

The user does not have the option to select variables (i.e., the Select Variable(s)  and Selected

Variables list boxes do n ot appear).
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Figure 38. The uncertainty analysis specifications dialog.

Figure 39. Pearson correlation coefficients between selected

simulation output variables and the total aggregated dose

over all pathways.

Uncertainty Analyses

If the user selects “Uncertainty” in the SELECT SAMPLE METHOD box on  the View  Results

dialog, the “Uncertainty Analyses” dialog appears.

In the SELECT OUTPUT

FILE TO A NALYZE , the

user can select only from

outpu ts of unce rtainty

simulations. 

If either the Spearman

Correlation, Pearson

Correlation, or Stepwise

Regres sion ana lysis

methods are selected by the

user in the SELECT

ANALYSIS METHOD list

box at the bottom of the

screen, the user can select variables to include in these uncertainty analyses using the

SELECTED VARIABLES TO INCLUDE IN ANALYSES list box. One or more variables can

be selected.  The selected variables

will appear in the SELECTED

VARIABLES list box.  To unselect

variables, click again on those

variables in the SELECTED

VAR IABLE S TO IN CLU DE IN

ANALYSES list box. 

Correlations

For “Spearman Correlation” and

“Pearson Correlation” selections,

the selected variables appear along

with their correlation to the total

dose a ggregated over all p athways

for both playsets and decks (Figures

39 and  40). 
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Figure 40. Spearman correlation coefficients between the

selected o utput v ariables an d the total d ose aggre gated ov er all

pathways.

Figure 41. Sensitivity analysis of output data using stepwise

regression.

Stepwise Regression

For “Stepwise Regression”, the selected variables are listed in a table along with results of the

analysis. The analysis adds and/or deletes individual input variables into a regression model

predicting the total aggregated

dose over all pathways.  The

results of this analysis give a

statistical relationship between

the model inputs and the output

dose (Figure 41). The statistics

displayed  include  partial R 2

correlation coefficient, model

R2 correlation coefficient, and

significance pro bability (Pr>F).

If none of the selected variables

have a sig nificant re lationship

with the total dose then the

table w ill be em pty.
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Figure 4 2. Varia bility betwe en three  represen tative unc ertainty

iterations. E ach line s hows th e total dose  of all indiv iduals in  a single

uncertainty iteration.

Population Uncertainty Cumulative Density Functions

These show

representative

cumu lative den sity

functions (CDFs) for

the entire population

in uncertainty runs.

Only the total

absorbed dose from

playsets an d deck s is

plotted. The user has

no options to choose

specific input or

output variables.

Let us assume that the

user has made an

uncertainty run with a

population of 1000

and a sample size of

100. This means that

1000  individ uals will

be simulated 100 times each. These CDFs look at the results in two ways. The first shows typical

uncertainty for high dose, medium dose, and low dose individuals (Figure 42). The second shows

uncertainty for the en tire population (F igure 43).

Uncer tainty for R eprese ntative In dividuals

Choosing “Three Selected Population Profiles” allows the user to look at three representative

populations (Figure 42). Using the example started previously, there are 1000 individuals which

have been simulated. The uncertainty iterations can be ranked from 1 to 100 based on the median

total dose calculated  for each of the 1 000 ind ividuals in that iteration. T he iterations that are

ranked 5th, 50th, and 95th of the 100 iterations (the 5th, 50th, and 95th percentiles) are selected for

this analysis. The CDFs represent the the total dose (mg /kg/day) of all individuals in these

iterations. Thus, each line contains 1000 numbers for the given example.

Population U ncertainty

Choosing “All Population Profiles” allows the user to look at uncertainty for the entire population

(Figure  43), wh ich can b e useful in  regulatory d ecision m aking. F or each o f the 10 00 nu mbers in
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Figure 43. Uncertainty of entire population.

the 100 runs, a 5th, 50th, and 95th percentile is obtained. The three CDFs in Figure 43 each

represent 100 values. These show the uncertainty associated with each of these percentiles for the

entire population.
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Figure 44. The dialog for user management of simulation

datasets.

Manage Output Files
The dialog that appears upon clicking the Manag e Output Files button  in the m ain dialog  is

shown in Figure 44.  A number of

files are associated with each

model run. This dialog allows the

user to delete unneeded files from

previous simulations. The user

selects the SHEDS output files

from the top list box. The selected

files appear in the low er dialog. 

The files are deleted when the

user selects the Delete V (for

variability files) or Delete U for

(uncertainty files) buttons.

Exit
Clicking on the Exit  button on the

main dialog removes the SHEDS

interface sc reen, bu t typically

leaves the user in SAS.  Output, log, editor, and graphics screens from the session will still appear

unless closed by the user.  The easiest method of starting a new SHEDS session is to exit SAS

and restart using the the desktop icon. To exit SAS completely, select the File , menu then Exit

(File>E xit). 

Future Modifications
Some changes that may be incorporated into subsequent versions of the SHEDS-wood interface

include the fo llowing: selection of d ifferent cohorts besid es ages 1 to 6 years;  inclu sion of a

"cancel run" option and an indicator for "estimated time remaining" in a model simulation;  and

ability to prin t results and exp ort them  to other sof tware form ats (e.g., Ex cel)
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Figure 45 Distributions supported in SHEDS: point, uniform, normal, log-normal, and triangular. Each

curve is normalized so that its area is approximately 10 units.

Background Topics

Distributions and Sampling 
The SH EDS -Pesticide mod el supports five d istributions as previo usly listed in Table 2 . A

diagram sh owing these  distributions is given  in Figure 45 . The distribu tions and their p arameters

(as shown)  are:

1. Point:  value of 17.

2. Uniform: minimum 5, maximum 15.

3. Norm al: mean 10, standard deviation 2.

4. Log norm al: geometric me an 3 and  geometric stand ard deviation 1 .35. or exp (0.3).

5. Triangular:  minimu m 2, mod e 10, max imum 1 8. 

Each parameter mu st be specified to fully define the distributions.
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During the model run, a specific parameter may be sampled many times. There is no guarantee

that the parameter will be a specific value unless the point distribution is used. If the uniform or

triangular distributions are used, the value will not be greater than the maximum or less than the

minim um. If the  norma l distributio n is used , one can  only be ass ured th at the valu e will be w ithin

two standard deviations of the mean about 96% of the time. However, in all cases, if enough

samples are tallied, the population of values will resemble the distribution used. That is, the

tallied samples should have the same central tendency, spread, and skewness as the population

from which they are drawn. However, the current implementation of the model sets upper and

lower bounds in certain cases to prevent physically impossible values from being chosen. If the

distribution return s a value outside  the boun ds, then the d istribution is resamp led. 

Assume for a mom ent that one specifies an absorption rate for the gastrointestinal tract (GI) as a

normal distribution with a mean of 0.00025 and standard deviation of 0.0001. It cannot be

determined a priori what a specific sample value will be. We know that about 67% of the time

the value will be between 0.00015 and 0.00035 within 1 standard deviation of the mean, and

about 96 % of the time  the value will be b etween 0.0 0005 a nd 0.00 045, or w ithin 2 standa rd

deviations.

Lognormal Distributions 

Logno rmal distrib utions are  used for  many of th e SHE DS p arameter s. A population  that is

lognormal will become normal after the application of a log transform to the values. In SHEDS,

these distributions are specified using the geometric mean and geometric standard deviation.

These are the mean and standard deviation of the normal population that have been converted

back (exponentiated) to the scale of the original data.

Single-Stage Monte-Carlo Simulation

Below is a simple equation (1) to demonstrate how the variability distributions work in the model

using sin gle-stage M onte-Ca rlo samp ling. Sin gle-stage sam pling w ill accoun t for real variatio n in

the parame ter values in the p opulation. E quation 1 h as two param eters: Variable 1 (V 1) and

Variable 2 (V 2).

Result = V1 * V2

Equation (1) Example equation for use in explaining

Monte-Carlo modeling.
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NOTE: The example values were chosen so that the result will typically be around 100.

Assume for the moment that this equation is part of the exposure model. Before calculating the

result for any time period , the model w ill pick specific param eter values for V 1 and V2 based on

the inpu t distributio ns. Th ese value s will rema in consta nt for the sim ulation o f the ind ividual.

! V1: This variable will be defined as coming from a normal distribution with a mean of 20

and a standard deviation of 2.

! V2: This variable will be sampled from a uniform distribution with a minimum of 4 and a

maximum of 6.

Having chosen the parameter values, they will be applied to the calculations for a specific time

period, usually either one event, one time-step, or the simulation for one individual. Over the

course o f the entire  simulatio n the valu e of the resu lt will take on  a variety of valu es. Visu ally this

can be re presen ted as in F igure 46  where s pecific va lues cho sen du ring one  iteration are  used to

calculate the final result. Additionally, the figure shows the frequency histogram of 1000 such

samples.

In the figures, defined distributions are represented by smooth curves; distributions resulting from

repetitive sampling are shown as bar charts with several bars. Uncertainty distributions are shown

in red, variability in blue.
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Figure 4 6 Visu al represen tation of sin gle stage M onte-Ca rlo samp ling. On e calculatio n for the e xamp le

equation (V1=22.8, V2= 4.44, and R esult = 101.2) and its relative location among 1000 such

calculations.  
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Two-Stage Monte-Carlo Simulation

Single-sta ge Mo nte-Carlo  simulatio n accou nts for real variab ility in the population (e.g., the

actual diff erences in  metabo lic rate from  person  to person ). In contra st, two-stage  Mon te-Carlo

simulation is used to assess uncerta inty in the model due to our lack of knowledge about

parameter values.

For two-stage simulations, it is necessary to choose a distribution for each parameter of each

variability distribution. Fo r instance, in the p revious exam ple, V1 was assumed to have a normal

variability distribution with a mean of 20 and a standard deviation of 2 (Figure 46). The normal

distribution requires two parameters, the mean and standard deviation. In two-stage sampling, we

need to define a distribution for the mean, and another for the standard deviation. We might

decide that the mean is “typically” between 18 and 22. This could be modeled using a normal

distribution w ith a mean of 2 0 and stan dard deviation  of 2 (Figure 4 7, Mean1, top row, left).

Likewise the stan dard deviation  of V1, StdDev1, could be modeled as a uniform value between

one and th ree (Figure  47 , top row mid dle).

The secon d variable, V2, has a uniform variability distribution. This also requires two parameters,

the minim um and  maximu m. Its variability distribution u ses a minimu m of 4 and  a maximu m of 6

(Figure 46 ). We cou ld model th ese with two d istributions (Figu re 47, second  row), for Min2 and

Max2 . Min2 is modeled as uniform with a minimum of 3 and a maximum of 5. Max2  is given by

a uniform with a minimum of 5 and a maximum of 7.

The user w ill specify the numb er of uncertainty iterations an d individu als to be simulated  before

the run . Durin g the sim ulation ru n, at the b eginnin g of the first u ncertain ty iteration, 4 v alues will

be chosen to define Mean1, StdDev1, Min2, and Max2  during the iteration. These four values

will be derived from the uncertainty distributions (red distributions at the top of Figure 47). The

values describ e the variability distribution s of V1 and V2 (third row, left and middle, Figure 47)

for this uncertainty iteration. These two distributions will be used to draw samples for each

individual d uring this un certainty iteration (Figure 4 7, third row, righ t).  

At the b eginnin g of the n ext unc ertainty iteration , the four d istribution s will be sam pled ag ain to

define Mean1, StdDev1, Min2, and Max2 , and thus th e new variab ility distributions for V1 and

V2 (fourth ro w, left and  middle , Figure 4 7). For th is uncerta inty iteration th ese new  variability

distribu tions will b e samp led each  time a ne w value  is neede d for the re sult (fourth  row, righ t,

Figure 47 ). This process w ill be repeated for eac h uncertain ty iteration (Figure 47 , fifth row).
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Figure 47 . Visual exam ple of two-stage M onte-Carlo sam pling. 


